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Supported Operating Systems and Browsers 
The following tables show the operating systems and browsers currently supported. 

 

Note: All of these operating systems and browsers are supported, but some may not be 

actively tested. 

 

 

 

 
 

 
  

Browser Version 

Microsoft Edge latest 

Google Chrome latest 

Mozilla Firefox latest 

Safari latest 

Platform OS Version 

Desktop 

Windows 10 

Mac 10.13.4 (High Sierra) 

Mobile 

iOS 11.4.1 -> latest 

Android 6.0.1-> latest 
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Human Resources 

Hot HR Features in this Release 

Social Security Number Verification Service (SSNVS) is Back! 
We are happy to announce the return of the Social Security # Verification button and functionality for 

those companies who have the SSNVS marketplace product enabled. The button can be found in the 

following areas of the product: 

• Employee Information: Manual Hire Page 

• I9 Form: Team > HR > Forms > Government Forms > I9s 

Gender Inclusion 

Non-Binary Gender Option Added to System 
To provide more options for gender inclusion, the system will now provide a new Non-Binary/X option. 

The Use Extended Genders setting is available in Company Setup, located in the HR Settings widget 

under Company Settings > Global Setup > Company Setup.  

 
 

Note: This setting will be checked by default, as 20+ states have regulations recognizing 
gender Non-binary/X .   

 

When the setting is checked, a Non-Binary option will display in the list of options under the Gender 

drop-down in the Account Demographics widget of employee profiles.  
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The gender code for Non-Binary will be X. Current codes: Undefined = U, Male = M, and Female = F. This 

code will display in the Gender column of reports where the column is available and added. The new 

gender option will also be available for PDFs.  

Once this option has been selected for at least one employee, the option in Company Setup cannot be 

turned off (unchecked). An error message will display informing the user why the option cannot be 

turned off. The setting will be checked by default for all companies and all EINs.  

Opting Out 
For companies who choose not use this option, or may have religious exemptions, or are simply not 

required to provide this option per the laws of their state, they may uncheck this setting. Opting out will 

hide the option from selection and reporting. The Undefined option will still be available. 

HR Actions 
HR Actions will recognize the X/Non-Binary gender code so users will not have to update employees 

manually as they are hired or processed. Assuming the Use Extended Genders setting is enabled in 

Company Setup, the following can be expected. 

HR Action Sub Type = Hire, Re-Hire, or Regular: The Gender drop-down will include the Non-Binary 

option. 

Note: The Manual Hire Process will include the Non-Binary option in the Gender drop-down 
field. 

 

Employees Import 
The Employees Import template is updated for the use of the X gender code. This affects the XLS, XLSX, 

and XML options. Assuming the Use Extended Genders setting is enabled in Company Setup, the 

following can be expected. If this field has not been enabled, using Gender X will result in processing the 

import and then present users with a warning that Gender X is invalid for the employee(s).  
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• The Instructions tab is updated in the Description of the Gender row. Valid values include: M, F, 

U, or X. 

• The Template tab will validate the values and recognize X as a valid option. 

Company Settings Import 
The Company Settings Import template is updated with field name Use Extended Genders which allows 

you to determine via import if the non-binary gender option is available. This field has been added to 

the HR Settings section of the Instruction tab of the template. The column is not a default column in the 

Template tab and must be added. Y and N are valid values to determine if the setting will be enabled or 

not. If the value is not specified or is invalid, the system does not change the value in the company. If at 

least one employee in the company is listed as Gender X/Non-Binary and the value in the column is N, 

the value is not processed and an error displays.  

Legal First Name Option Added to System 
 

Important: In this release, the Legal First Name field will not be available if the Payroll sub-

system is enabled. This field is coming to Payroll companies in a future release. 

 

In addition to offering the Non-Binary option for gender identity, a new Legal First Name field has been 

added to employee profiles. Employees' preferred name can be added to the First Name field and their 

legal first name can be added to the new field, as there are still cases and places in the system where 

their legal first name must be used. This will allow employees to be addressed by their preferred name 

when the legal name is not required.  

The field is located in the Account Information widget between the Suffix and First Screen fields.  

 
 

 

Security: A new checkbox for Legal First Name is available in the View/Edit (Custom) permission for the 

Account/Personal Information setting in security profiles, located in the Employee section of the HR tab. 

Users will select the Permissions button to open a pop-up. An Info icon displays a message that Legal 
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First Name will be displayed on legal documents such as pay statements, withholding forms, year-end 

tax forms. View and Edit options are available on this pop-up.  

• This permission is also available in the Employee section under the ESS tab for employees who 

are allowed to view and/or edit their employee profiles.  

HR Actions: HR Actions can contain the Legal First Name field so users will not have to update employees 

manually as they are hired or processed. Assuming the Legal First Name permission is enabled (View or 

View/Edit) in the security profiles, the following can be expected. 

HR Action Sub Type = Hire, Re-Hire, or Regular: The Legal First Name field will display and can be 
used. 

Note: For the Legal First Name field to be available in the Manual Hire process, the security 

permission must also be enabled. 

 

Custom Forms: When selecting Type: Employee in a custom form page, Legal First Name will be available 

as an option from the drop-down. For this to be available, users must have security permission to the 

Legal First Name field. Users without this permission will not see it in the drop-down, and users without 

permission will not see the field in the form. 

Reports: The Legal First Name column can be added as a column to the Employee Information report 

and other employee related reports. The column is not displayed by default and must be added. 

I9 Forms: If a Legal First Name has been specified, the system will use this name over the preferred 

name listed in the First Name field. This will also apply when using E-Verify.  

W4 Withholding Forms: For companies without the Payroll sub-system enabled, if a Legal First Name has 

been specified, the system will use this name over the preferred name listed in the First Name field. 

Existing forms will not be updated but can be manually edited. This impacts all withholding forms, both 

federal and state. Security Permissions for Legal First Name do not affect visibility of Legal First Name in 

Withholding Forms. 

New Hire Reporting: If using Legal First Name along with First Name in employee records, the Legal First 

Name will be used in system Data Exports (Company Settings >System Data Export > Data Exports). This 

will be available for the New Hire Reporting exports for all states, including the Generic Version, the 

Faxable Version, and SSNVS.  

Employees Import: The Legal First Name field has been added to the XLS and XLSX versions of the 

Employees import template. The field is explained in the Basic Employee Information section of the 

Instructions tab. On the Template tab, the field is located between the First Name and Last Name fields.  

Employee Profiles: The Legal First Name field, if used, will be included in the Employee Profile PDF. 

Other areas affected by Legal First Name field: 

• Group Permissions: new field included 

• GDPR requirement met 
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• Language localization supported 

• Available in mobile app 

NOT available for the Applicant Profile page: only available for hired employees 

Audit Reports support new field: Account Info report (located at My Reports > System Reports > Audit 

Trail), and Master Data Changes report (located at System Reports > Audit Trail) 

Search: Users with permission to view and use Legal First Name fields will be able to use Search to locate 

employees by their legal first name. Users without this permission will not be presented the results.  

Job Applications PDF Download 

Recruiters and managers can now view and download job applications in PDF, including 

questions/answers and applicant signatures. This option is located under Team > Recruitment > 

Candidates > Job Applications in the Quick Actions menu, under the More Actions drop-down. 

Applicants will also have the ability to download their complete job application in its entirety, including 

their job related questions and signature.  

We have added to the system a downloadable PDF of the Job Application Summary that includes the 

header from the configuration, job title for the application, opening/intro verbiage provided by your 

company, all fields in the My Applicant Profile, all questions and answers completed in the job 

questionnaire (if applicable), the consent/acknowledgment verbiage provided by your company, and the 

signature with date stamp (if applicable). This is a point-in-time PDF.  

We have designed the Job Application Summary to behave slightly different from the Applicant 

Summary. Here is why: 

• Applicant Summary: When electronic signature is enabled, the applicant signs once and is never 

presented the ability to sign again, even if they make changes to their profile information. 

• Job Application Summary: When electronic signature is enabled, the applicant always has the 

ability to sign for every application. The Job Application Summary is a snapshot in time at the 

time of signature. So when you look at the Job Application, the signature is for the information 

contained and can never be changed after the signature. 

• If signature verbiage from the Applicant Summary tab should be the same in the Job Application 

Summary PDF, make sure to copy the verbiage to both Summary tabs 

Job Applications: Choosing Company Name in PDF 
A drop-down field has been added next to the Company Name field in the Job Application 

Configuration widget within the Configuration page under Company Settings > HR Setup > Applicant 

Tracking/Recruitment > Configuration. The options here include DBA Name, EIN Legal Name, and 

Company Name. These selections will display on the Job Application Downloaded PDF.  

The company names are pulled from the Company Address widget in the Company Setup page, located 

under Company Settings > Global Setup > Company Setup. An Info icon tells you how the system will 

cycle through the names if left blank (unchecked.) 

• If blank: the Company Name shown on Job Application will be DBA 

• If DBA blank: system uses EIN Legal Name 
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• If both DBA and EIN Legal Name blank: system Company Name is used 

 

 

Offer Letter Workflows 
In the December 2020 system release, Offer Letters functionality was released. In this release, we are 

adding Offer Letter workflows. The workflow will be available as an editable default workflow or can be 

manually built. The workflow contains many of the standard steps, actions, and filters just as other 

workflows do. Workflows are located under Settings > Global Setup > Workflows.  

• Where it is used: The workflow is placed in the Offer Letter Workflow field in the Applicant 

Tracking/Recruitment Configuration page, located under Settings > HR Setup > Applicant 

Tracking/Recruitment > Configuration. The field name is hyperlinked and when selected will open 

workflow maintenance. 

• Why it is used: The workflow is meant to give the user the ability to configure in such a way that 

multiple managers can take action (approve/modify/reject) and finalize accordingly. 

• How it triggers: As soon as a user fills out the details in the Offer Letters page and submits, the 

offer letter workflow is triggered provided the user has selected a workflow in the Offer Letter 

Workflow field on the recruitment configuration page. One the workflow is initiated, editing of the 

offer letter will not be allowed.  

• Report columns: In the Offer Letters report page, you can add two new columns, Workflow Status 

and View Workflow. The status of workflow will change in the Workflow Status column as the 

workflow goes through its process.  

• Approval/Rejection behavior: Once the workflow is approved and completed, the offer status will 

change to Offer Generated and then a PDF is generated. If not approved and completed, the offer 

status will be set to Rejected and the offer letter page will be read-only without any action 

buttons. 

• Deleting an active workflow: When there are offer letters with a workflow in progress and the 

workflow is removed from the configuration page, the following can be expected: 

• All the offer letters will be generated regardless of the state they are in the workflow. 



 

13 

• All the related To-Do's will no longer be displayed. 

• The offer letter report will remove the workflow & workflow status for the associated offer letter 

when they are in progress. For all the offer letters for which workflow is completed, the workflow 

& status will still exist and will not be affected. 

• If the workflow is modified or deleted or the applicant hired, we will capture a point-in-time 

snapshot to be displayed in the report for all completed offer letter workflows (either approved or 

rejected). 

• Managed Cost Center (MCC) Permissions: MCC managers will have the ability to select a cost 

center manager within the Approve/Reject step of the Offer Letter Workflow if they have the 

following permissions set within their Managed Cost Centers widget in their employee account.  

• Within the Managed Cost Centers widget, select the Edit Cost Center Permissions action for the 

desired cost center. Check Approve HR Action Workflow and set the Approve Level and save.  

Preboarding/Onboarding 

In this release, we are pleased to introduce Preboarding and Onboarding. Onboarding can be a critical 

part of the new employee experience. Many studies have shown that a properly onboarded employee is 

far less likely to leave their new employer within the first year of being hired. 

The new Preboarding Portal and Onboarding Dashboard tab can be utilized to increase engagement and 

promote company culture for new hires from the time their offer letter is signed through their first year 

of employment and beyond. 

The preboarding period, in this context, is defined as the time between the new employee signing their 

offer letter and starting their first day of work. The preboarding portal allows you to maintain a level of 

engagement by allowing a new employee to access information about your company culture and work 

environment as well as the opportunity to start their new employee paperwork (I-9, withholding forms, 

etc.) 

In order to utilize the functionality, the new employee needs to be hired into the system as an employee 

and assigned an onboarding profile. At that point, they can be provided with a link and login credentials 

to the preboarding portal. 

Performance Goals: Cascading and Aligning Public/Private Goals 
A new option to set goals as Public or Private is now available. Public goals can be cascaded and aligned 

to other employees while private goals cannot. This option is available for managers and for employees 

who are allowed to edit their own goals. 

Cascade and Align Goals 
When choosing the edit option for a goal, option buttons for Cascade Goal and View Goal Tree are 

available. Using the Cascade Goal button opens a Browse and Select Employees page where you can 

select one or more employees who should also receive the goal.  

While assigning or editing a company goal, you can designate the goal as public or private. An Info icon 

contains a tooltip reminding users that only public goals can be aligned and cascaded. It will default to 

Private on all existing goals to ensure backwards compatibility, but this field can be edited. 
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• Cascade Goal uses the concept of Copy but also links the associated goals together so they can be 

seen as impacting each other. Cascading can only happen if you have subordinate employees. 

• Align is the same as cascade except it is associated up to a manager's goal. Aligning is based on the 

6 Manager slots. 

• The view is available for both managers and employees with security permission to access their 

own performance reviews.  

 

 

Goal Tree View 
A View Goal Tree icon/button is available to be added to the Performance Development report page. 

When selected, a graphical view of the goals will display showing cascaded and aligned goals and how 

they impact each other. Within the tree view, a percentage complete indicator will display for each goal 

and each employee for whom a goal has been assigned.  

For the goals, manager options are available within the tree view to:  

• Align Goal: A list of the manager's direct reports will display. Clicking/selecting an employee from 

the list will align the goal to that employee. 

• Cascade Goal: A Browse/Select Employee pop-up will allow managers to select employees for the 

cascading of the goal.  

• Notes: Jumps to the Notes widgets of the goal. 

• Review Audit: Jumps to the Audit widget of the goal. 

For employees in the tree who have linked goals, the option of Remove Linked Goals is available. A 

warning will display to the user before proceeding. Removing linked goals remove the link between 

those two employees.  
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Color Coded Goal Percentage 
Additionally, the color-coded Goal Percentage Complete column is back! This column is available in the 

Performance Development report page under Team > Talent > Performance > Performance 

Development and also for employees under My Info > My Career > Performance > My Goals.  

Copying Goals 
Historically, the creation of a goal has been accomplished via the performance review or through 

manual assignment.  

What's New: In this release, managers will be able to open a Personal, Company, or Shared goal and 

select Copy. This will make the goal available to be added to other employees. The copy will not carry 

over the Status, Percentage complete, Audit History, or any Private Notes from the original goal upon 

copy.  

Goals Created in Performance Review Available in Performance Development 
Previously, goals added only to a performance review did not become available in Performance 

Development. This one-sided creation of the goal made it difficult for managers to work through the 

goal during the review period, thus making it so the goal was essentially used at the end of the review 

period.  

What's New: All goals, including those added from a performance review will flow down to the 

Performance Development screen. This allows managers and the employees to work those goals 

throughout the year or review period and still review them with ease at the end of the cycle. Ensure 

goals are set with the Add To Performance Development checkbox checked, otherwise it will not flow 

down to the employees. 

  

HR Enhancements 

Base Compensation 

Menu Path for Base Compensation Maintenance 

The menu path to access Base Compensation Change Reason Codes has been changed to Company 

Settings > Global Setup > Global List Definitions > Base Compensation Change Reason Codes. This 

change was made to allow Payroll-only companies to access and customize their Base Compensation 

Change Reason Codes. The Base Compensation required checkbox in the Account Policies widget of 

Company Setup will now be hyperlinked for both HR and Payroll only companies. The hyperlink will take 

you to the menu option mentioned above. 

Custom Forms 

Select Level Information Added for Custom Form Field Settings 

When creating a Custom Form, such as for an employment contract, users can select cost center(s) 

which will populate the default cost center from the employee record but could not pull additional cost 

center level information that could provide more detail needed for managers and others.  
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What's New: We have added Select Level Information to the Cost Center Field in custom forms where 

the user can select the cost center level and field (Name, Abbreviation, Description, Address fields) from 

the cost center to populate as a read-only field on the custom form. 

 

• From the Field Settings in a Custom Form configuration page, select Type: Employee 

• Select Cost Center 1-9 

The Select Level Information option will become available. Select the edit icon.  

 
The Cost Center Tree Name is grayed out. You can choose the Cost Center Level and Field. The options 

in these drop-downs will be validated according to how the cost center is set up and which fields in the 

cost center are enabled, labeled, etc. The system validates against what is set up in the cost center(s). 

This only affects Employee custom forms and is not available for Applicant custom forms since 

applicants do not have assigned cost centers. The additional cost center information will display as read-

only, preventing users from editing the cost center information from the custom form.  

Points Details Field Available for TLM Only Companies 
In the February 2021 system release, we added a Points Details field in Custom Forms for Type = 

Employee. In that release, this field could only be used by TLM companies who also had the HR sub-

system enabled. 
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What's New: In this release, we have added the Points Details field for TLM only companies. This is 

configured under Team > Time > Points > Custom Forms. Select Type = Employee and the Field drop-

down will display only the Points Details option.  

The Points Details field is still available in HR only companies. 

Custom Forms Available for LOA Companies 

Users can now set up Leave of Absence custom forms in companies, providing the Leave of Absence 

setting is checked in the Available Functionality widget of the company (Admin level). The form is 

available only for employees and is not available if the Is Applicant checkbox is checked. 

When creating or editing a form, a new field from the Fields widget. In the Field Settings widget, a new 

option, LOA Case, can be chosen from the Type drop-down. You can then configure more information 

about the LOA case, such as the number of hours, start and estimated end dates, and reason.  

Once you are finished setting up the custom form, it can then be assigned under Team > HR > Forms > 

Other Forms from the Available tab by selecting Assign next to the applicable leave case. On the next 

screen, select the Populate LOA Fields button. A Populate LOA Fields from LOA Case pop-up window 

will display, which will show all the employee's leave cases. Select the radio button next to the 

applicable case, and the Leave Case screen fields will populate with the data. If ready, you can then 

select the Submit button.  

 
You can download a print version of the populated leave case by selecting the Download PDF button. 

From the Open tab of the Other Forms page, select the hyperlinked form name in the Form column to 

view the open case. From there, you can submit the form if not done previously. You can view 

submitted forms on the Submitted tab. In the Actions column, you can edit, download a PDF of the 

form, upload a document, assign another employee, view the history, delete, and view the detailed 

record.  
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Documents 

Benefit Plan Documents During EIN Transfer 

When performing an EIN transfer for an employee who has Benefit documents on file in their current 

EIN, such as EOI, those documents will be copied/moved over to the new EIN without creating new 

additional documents in the new EIN. This will prevent your company's document storage from 

becoming overinflated.  

HR Actions 

Clone Option Added to HR Actions Configuration 

You will now be able to clone HR Actions on the configuration page, located under Settings > HR Setup > 

HR Actions. A new Clone button column is available to be added to the report page. This will not be on 

the page by default and must be added. It will be available in each row as you create HR Actions. Cloning 

enables you to copy an existing HR Action and then rename and edit it. 

'Require New Document' Setting Added to Documents HR Action Item 

When the Documents action item is included to an HR Action and marked as Required, the user is 

required to upload a document and cannot proceed until this condition is satisfied. However, if there 

were already document(s) uploaded/saved prior on the employee record, the system saw the previously 

existing documents, which satisfied the validation requirements and did not require the user to upload 

any new documents. Therefore, the uploading of the newly required document could be bypassed. 

What's New: We have added a Require New Document option to the Documents HR Action Item which 

will require a new document to be uploaded as part of that HR Action. When checked, even if 

documents already exist for the employee, they must upload a new document and the system will 

validate the field as required and not let the employee proceed until the document is uploaded.  

Info icons have been added to the Documents HR Action item to inform users how the required 

checkboxes work.  
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Incidents 

More Required Fields Added 

In Incident Types (Settings > HR Setup > Incidents > Incident Type) we have increased the ability to mark 

certain fields as required.  

• Under Incident Info Required Fields section: 

• Violation (if enabled in Settings widget on same page) 

• Workers Claim (if enabled in Settings widget on same page) 

• Employee Signed (if Signatures is enabled in Settings widget on same page and Incident Types 

workflow is not enabled in Workflow Polices widget of Company Setup, as the workflow would 

handle these functions via the Sign steps) 

• Reviewer (if Signatures is enabled in Settings widget on same page and Incident Types workflow is 

not enabled in Workflow Polices widget of Company Setup, as the workflow would handle these 

functions via the Sign steps) 

• Review Signed (if Signatures is enabled in Settings widget on same page and Incident Types 

workflow is not enabled in Workflow Polices widget of Company Setup, as the workflow would 

handle these functions via the Sign steps) 

Jobs 

Job Attributes Limit Increased to 25 Items 

The limit for Job attributes created in the Jobs report page have been expanded from 10 to 25. This page 

is located under Company Settings > HR Setup > Jobs. On this page, attributes are added via the Define 

Attributes button. These attributes will display and can possibly be edited in a defined Job within the Job 

Attributes widget. The following areas will allow for up to 25 job attributes: 

• The Jobs report page 

• The Jobs Import template 
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• The Job Info History Report: job attributes display in the Field column with Old/New Value. 

• The Job Attributes widget in Employee Profiles: as jobs are added to employees, any attributes 

associated with the job will display in this widget as read-only field. If the job attributes on the 

assigned job change, these fields will change as well. 

• Employee Information report page: as job attributes are added to an employee, a corresponding 

column will become available to be added to the report page. 

User Locale Settings for Job Attributes 
When defining custom fields within Job Attributes, the attribute types of Date, Numeric, Currency, and Time will now 

be shown according to the user's locale settings. The job attributes display in the format specified in the user's locale 

from their employee profile and will display this way in reports and imports. 

 

Notifications 

Name Change to Created Event 

To better clarify the purpose of the notification event name Created, the name has been changed to Account 

Created. The updated name will display in the Event field of the Notification Description section.  

 

Performance Management 

Goals: Character Limit Tool Tip Added to Name Field 
Goal Categories, located under Company Settings > HR Setup > Performance Review > Goal Categories, have a 35 

character limit and a tool tip has been added to Name field to inform users of this limit and prevent errors when 

entering names that exceed this value.  

 

Recruitment 

Applicant Profiles: Single/Multi View Toggle 

A Single-Column View toggle has been added inside applicant profiles. Switching the toggle on will re-order the 

widgets in a single column. Switching it off will return the page to a multi-column view. This will not affect the Jump 

To panel on the left.  

Applicant Profiles: Position & Order of Tabs 
In the Applicant Profile Setup page, located under Company Settings > HR Setup > Applicant Tracking/Recruitment > 

Applicant Profile Setup, we have placed high numbered sort orders for the tabs: Cover Letter, Resume & 

Supporting Documents (32,740) and Job Application Summary (32,750). These sort order numbers are not editable 

and are set high to ensure these two applicant tabs always appear second to last/last and in proper order as 

applicants work through their job applications. 

 

Important: This change will impact all existing companies. 
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Job Application Updates: Adding a Logo and Header Information 

 A new Job Application Configuration widget has been added to the Applicant Tracking/Recruitment 

Configuration page. In this widget you can add a logo image, company name, and/or company address 

to the header page of your job applications. If you are multi EIN, you can select an EIN to apply the 

changes. You may need to add the widget via the Edit Tabs option. 

The Logo Image title is hyperlinked and when clicked will link out to Company Settings > Global Setup > 

Look & Feel > Upload Images. Here, you can upload and manage images. This information will be shown 

on downloaded PDFs. 

 

Recruiting Workspace  

Recruiting Workspace: Workspace Toggle 

Over the next couple of system releases the Try the New Workspace toggle located within Job 

Requisitions will be phased out and no longer available. The default view when opening a job requisition 

will be the workspace view.  

Recruiting Workspace: Vertical Label Names 

The left and right panels of the Recruiting and Employee Profiles workspaces will now display vertical 

labels along with the icons when those panels are minimized. This will allow you to see which options 

are available without having to memorize the icons. You will be able to select the options in the panels 

and that option will pop out without the need to pop out the entire panel.  

Recruiting Workspace: Hiring in Job Applications from Applications Tab 

A Hire button option that will invoke a Hire HR Action is now available. After accessing the workspace by 

opening a Job Requisition, you will select the Applications tab and then in the Applications widget select 
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the View Job Application icon for the desired applicant. The Hire button is in the Quick Actions section 

of the right panel. 

• This button only works with Hire HR Actions and will be routed through the workflow assigned to 

the HR Action. 

• On successful hire, the Time to Hire Report will display the record for the new hire. 

• Other job applications of the same applicant will become internal applications (since the applicant 

was hired into another job) and no Hire button will be available. 

• If an employee record is created prior to going through the hire process, the Hire button will not 

be available. 

When the button is selected, a pop-up containing the available HR Actions will display. If there is only 

one HR Action, the system will automatically open it. If there are multiple HR Actions, you can select 

which one to use. Continue the hiring process.  

 

To Hire using HR Action, check the Use HR Action for Hire checkbox in the Applicant 

Tracking/Recruitment Configuration widget, located under Company Settings > HR Setup > Applicant 

Tracking/Recruitment > Configuration.  
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Recruiting Workspace: Applicant Questionnaire Status Column Added  

To give recruiters/managers more visibility about the status of applicant questionnaires, a new 

Applicant Questionnaire Status default column has been added to the Applications widget in the Job 

Requisition workspace. The widget is located under the Applications tab of the workspace.  

Reports 

OSHA and Worker Claim Forms Pull Data from Claim to Form 

Users with access to OSHA 300A reports will now be able to run reports based on the location where an 

employee's accident took place. When the OSHA 300 or OSHA 300A forms are populated, employee 

Incidents are included based on the cost centers from the employees' worker claims and not from the 

default cost centers for the employees. 
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Time and Labor 

 Hot TLM Features in this Release 

Leave of Absence  

Custom Forms Available for LOA Companies 
Users can now configure Leave of Absence custom forms in companies with Leave of Absence enabled 

in the Available Functionality widget, and Custom Forms enabled in the Security Profile (under HR 

Tables).  

Navigate to HR Setup > Custom Forms. Select the Add New button to create a new custom form. From 

the Custom Form screen, select the Add New Page button, then select the Edit Page pencil icon to 

configure the custom form.  

In the Field Settings widget, select the new option, LOA Case, from the Type drop-down. You can then 

enter information about the LOA case, such as the number of hours, start and estimated end dates, and 

reason. Regular or custom field types are available to choose from the Field drop-down.  

Once you are finished setting up the custom form, you can assign the form from Team > HR > Forms > 

Other Forms. Select Assign, then choose the applicable employee. 

On the Leave Case screen, select the Populate LOA Fields button 

 

A Populate LOA Fields from LOA Case pop-up window will display, which will show all the employee's 

leave cases. Select the radio button next to the applicable case, and the Leave Case screen fields will 

populate with data.  
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Note: If your company does not have the HR Sub-System enabled, the Submit button will not 
trigger a workflow. This will be updated in a future release.  

You can download a print version of the populated leave case by selecting the Download PDF button. 

From the Other Forms page, select View Open to view the open case.  

 

You can also preview the form by selecting the magnifying glass icon.  

In the Actions column, you can edit, download a PDF of the form, upload a document, assign another 

employee, view the history, delete, and view the detailed record.  

New Timesheet 

Added Exceptions Tab 

As previously available in the Classic Timesheet, an Exceptions tab is now available to add to the New 

Timesheet. Previously in the New Timesheet, managers could only manage exceptions from the Time 

Entry tab via the Manage Exceptions pop-up; the Exceptions tab allows managers to quickly view and 

manage an employee's exceptions without having to open additional pop-up windows. In addition, you 

can configure additional columns to display under this tab that will show data from the Time Entry tab.  

 

In order for users to view the Exceptions tab, enable the following options in the Exceptions widget of 

the Timesheet Profile: 

• At least one exception must be enabled under Editable. If at least one exception is not checked as 

Editable, the Exceptions tab will not display. Any exceptions that are enabled will display for the 

manager under the Exceptions tab. 
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• The setting Show Exceptions To Employee must be enabled for employees to be able to view the 

exceptions under this tab.  

Additional Columns 
In the Timesheet Profile, in the Display section underneath the Exceptions widget, additional columns 

that pull data directly from the Time Entry tab are available to add to the Exceptions tab. You can 

enable the following optional columns: 

• Show Raw Time Entries  

• Show Adjustments  

Tip: Adjustments will display in the Exceptions tab under the Adjustments column as a link, 

which will navigate you to the Adjustments tab when selected. 

• Show TE Notes 

• Show Calc Time Entries 

• Show Extra Pay 

Tip: Extra pay will display in the Exceptions tab under the Extra Pay column as a link, which 

will navigate you to the Extra Pay tab when selected. 

Show Daily Notes 

Main Columns 
The Day column gives managers a quick way to see if a specific date has an exception on it.  

The Schedule column is available for managers to be able to easily see which schedule an exception is 

being added to or cleared from. 

Exceptions calculated by a Pay Calculations rule display in their own column with the exception label and 

color configured for that exception. To manually set an exception, select the drop-down from in this 

example, the Absent column, and choose Absent Set. This makes it easy for managers to distinguish 

which exceptions were manually added and which were calculated by Pay Calculations.  

To clear a calculated exception, select from the same drop-down and choose Not Absent. The exception 

will be grayed out and a Cleared label will display on top. If you do not have a label set for the drop-

down, the field will display Clear.  

All aspects of the Exceptions tab from the Classic Timesheet will function the same way in the New 

Timesheet.  

From/To Columns Order Can be Changed 
Managers can now customize the order of the From/To columns (which are grouped as one) on the 

Time Entry tab. This allows for the flow of the data on the timesheet to be more user-friendly for 

employees.  
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Adjust the order by arrowing up or down From/To in the Time Entry Collected Data section of the 

Timesheet Profile.  

New Report Shows Rates that were Entered on Timesheet 
Previously, there was not a report available to show custom rates entered directly on a timesheet in the 

Rate column, so users had to open individual timesheets to review this information.  

What's been added: A new report, Manual Timesheet Rates Changes, is now available under Team > 

Time > Reports > Audit Trail. This report will display custom rate data that was manually entered on 

timesheets so that you do not have to open individual timesheets to review this information.  

To utilize this report, navigate to Available Functionality, and within Global, enable the Rates and 

Manual Timesheet Rates Changes options. 

Enhancements 
The following enhancements have been added to this release.  

Accruals  

Only for Accruals 1.0:  The following enhancements affect Accruals 1.0 only. 

Accruals 1.0: Accrual History Report Additional Detail 

As previously available in Classic, the Accruals 1.0 Accrual History report now displays the Employee 

name and Time Off when viewing the Accrual History from the Balance widget in Employee Information. 

You can also view this information from Team > Accruals > Balances, then select View History.  

Accruals 1.0: Hyperlinks in Time Off Balance Cards 

Previously, for employees and managers, the Time Off Balances cards did not contain hyperlinks for 

Taken, Scheduled, Projected Accrued, and Projected Balance.  

Going forward, the Time Off Balances cards will contain these hyperlinks. In order for these fields to 

display, navigate to Profiles/Policies > Global Setup > Company Setup > Global Policies, then enable the 

Visible Fields within the Accruals Policies widget that you want displayed in the Time Off Balance cards. 

Only for Accruals 2.0:  The following enhancements affect Accruals 2.0 only. 

Accruals 2.0: Apply Carry Over On Various Dates 

Previously, Accruals 2.0 companies could only carry over at the beginning of a new accrual period. 

What's been added: As available in Accruals 1.0 companies, Accruals 2.0 users can now configure 

various dates for carry over to occur, such as after an accrual period. A new drop-down, Date To Apply 

On, has been added to the Date To Apply Carryover On section in the Carry Over rule. Choose from the 

following options: 

• Start of New Accrual Period 

• Calendar Day 

• First Day of First Pay Period 

• First Day of Last Pay Period 
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• n-Days after New Accrual Period 

• n-Months after New Accrual Period 

Note:  Start of New Accrual Period is the default option; configurations of preexisting 

carryover rules will not be impacted.  

Accruals 2.0: Export Payroll Format: Added Accrual Category Option 
Previously in Payroll Export Format, Accrual Time and Day information was available, but users did not 

have the option to include an Accrual Category name and additional information.  

What's changed: The Accrual Category can now be included in Payroll Export Format, where you can 

enter the Name, Description, External Id, and Payroll Category. 

Accruals 2.0: Time Worked Grant Rule V2 
The Time Worked Grant Accruals rule has been updated to Time Worked Grant V2.  

Note: The Time Worked Grant V1 rule will continue to work, but if you need to update 
configuration in this rule, you will need to use the Time Worked Grant V2.  

In the Entitled To table define how much the employee accrues based on how many hours they work. In 

the previous version of this rule, the system entered a default calculation of days worked; in this new 

version of the rule, you can define the number of hours that an employee must work.  

 

All other settings in this rule work the same way as V1.  

Accruals 2.0: Limit Time Off Taken in Period 
A new Accruals rule has been added, Balance Limit within Period, which allows you to set a limit on the 

amount of time off that can be taken within a defined period.  
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This rule defines what an employee will have as an Available Balance (what an employee has available to 

use during the period) versus Total Balance (total amount an employee has accrued). Based on the 

parameters you set in this rule, the balance will not exceed that amount. The employee's Available 

Balance will display in the Accruals widget of the employee's profile, as well as in the Time Off Balances 

cards.  

Accruals 2.0: Balance Widget Hyperlinks for Accruals Policies 
As previously available in Accruals 1.0, in the Balance widget in the Employee Profile, Accrual Policies 

under the Type column are now hyperlinks that will take users with view security permissions for 

Accrual Profiles directly to the Accrual Policy configuration in the Accrual Profile.  

Accruals 2.0: Hyperlinks in Time Off Balance Cards 
Previously, for employees and managers, the Time Off Balances cards did not contain hyperlinks for 

Taken, Scheduled, Projected Accrued, and Projected Balance.  

Going forward, the Time Off Balances cards will contain these hyperlinks. In order for these fields to 

display, navigate to Profiles/Policies > Global Setup > Company Setup > Global Policies, then enable the 

Visible Fields within the Accruals Policies widget that you want displayed in the Time Off Balance cards. 

Accruals 2.0: Disclaimer in Accrual/Global Policies 
As available in Accruals 1.0, in Accruals 2.0 companies, a Disclaimer field has been added to Global 

Policies, Accrual Policy Settings, and Accrual Policies. The field allows for up to 1024 text characters, 

and if used, will display in the Accrual Balance widget in Employee Information. You have the option to 

set a disclaimer for each Accrual Policy.  

In addition, a Disclaimer field will now be available in the Accrual Balance widget in the Time Off 

Request screen.  

Accruals 2.0: Issue with Remaining Balance and Time Off on Same Day 
Previously, when a manager used the Change Remaining option to update an employee’s remaining 

balance as of a specific date, any time offs later added for that same date were not deducted from the 
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remaining balance. With this update, any time offs added for the same date as specified via the Change 

Remaining option will be deducted from the employee’s remaining balance. 

Accruals 2.0: Move Accrual Balance 
You can now move an Accrual balance at any time if it exceeds a configured threshold.  

What's been added: A new Accruals rule has been added, Move Balance, which allows you to move the 

balance of one accrual to another based on the conditions set.  

 

Note:  Incremental is currently the only Type available. Other Type options will be available in 
future releases. 

Enter the number of hours that need to be reached in order for the balance to be moved, then specify 

which accrual the balance should be moved to.  

Accruals 2.0: Negative Balance Did Not Expire 
Previously, negative Accrual balances did not expire on the date/date range set in Expiration.  

Going forward, negative Accrual balances will expire based on the configured dates, as expected.  

Cost Centers 

Cost Center Lookup Redesign: List/Tree Sticky View 
When you click Browse in the cost center field, whichever view you previously selected a cost center 

from, will display. 

Example: If you selected from the Tree View, the Tree View tab will display by default when 

the Browse and Select Cost Centers pop-up displays. 

Custom Forms 

Points Details Field Available for TLM Only Companies 
In the February 2021 system release, we added a Points Details field in Custom Forms for Type = 

Employee. In that release, this field could only be used by TLM companies who also had the HR sub-

system enabled. 
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What's new: In this release, we have added the Points Details field for TLM only companies. This is 

configured under Team > Time > Points > Custom Forms. Select Type = Employee and the Field drop-

down will display only the Points Details option.  

The Points Details field is still available in HR only companies. 

Allow Multiple Alternate Managers 
Previously, managers could delegate to only one manager at a time. 

What's changed: Under Settings > Global Setup > Groups > Manager Group Access, a manager now has 

the ability to assign up to five alternate managers who will have the same permissions as the original 

manager. They will also receive the same To-Do items.  

Leave of Absence  

ESS View Entitlement Widget 
Previously, only managers and HR Admins could view employee Leave of Absence entitlement balances.  

What's been added: Employees can now view their LOA entitlement balances and expiration dates.  

An Entitlement widget will now display in the employee's Leave of Absence Request screen (My Time > 

Leave > Request). This widget includes the Leave of Absence Category, Entitlement amount, number of 

hours Taken, Taken As Of date, and the Balance the employee has left. 

In order for the Entitlement widget to display for employees, navigate to the their Security Profile and 

within the Tools & Documents widget under the ESS tab, enable My Leave Entitlements.  

MSS Request Leave on Behalf of an Employee 
Previously, managers could not create leave requests on behalf of their employees, they were limited to 

creating cases. 

What's new: Managers can now create requests on behalf of their employees. A new Menu item, 

Request, has been added under Team > Leave.  

From the Leave of Absence Request screen, when you choose an employee, the screen will populate 

with Leave of Absence Request, Entitlement, Custom Fields, and Recent Requests widgets to fill out on 

behalf of the employee.  
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The Entitlement widget on this screen is available for managers with the Manage Requests checkbox 

under the HR tab enabled in their Security Profile.  

Manual Entitlement Setting for LOA Categories  
In the Entitlement widget for managers and employees, Calculated and Manual data can be included.  

For manual data to be included in the Entitlement widget, navigate to the Leave of Absence Profile and 

in the Categories section, enable the checkboxes under Manual Entitlement for any created 

LOA categories.  

If a category is checked as Manual Entitlement, that category will not be an option to choose from the 

Leave of Absence Category drop-down in an Entitlement rule. If a category is already being used in any 

of the Entitlement rules, you will not be able to check Manual Entitlement box for that category.  

For categories that are manual, the category name will display with 0 under Manual in the Leave of 

Absence widget in Employee Information.  

Manually Adjust Entitlement Balance  
Previously, users could only update entitlement balances using an API or import.  

What's changed: Users can now manually add, deduct, or set an entitlement balance. From the Leave of 

Absence widget in Employee Information, select the three-dot ellipsis and choose Edit Leave of Absence 

Balances. An Edit Leave of Balances pop-up window will display so that you can manually edit the 

balances. 
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New Leave of Absence Entitlement Rules Added 
Three new rules have been added to the Leave of Absence Entitlement rules: 

• Entitlement Based On Averaged Worked Hours 

• Entitlement Based On Averaged Worked Hours (Counter) 

• Entitlement Based On Averaged Scheduled Hours 

Pay Calc 2.0: Enhanced Round In/Out Time Rule 
For companies that are required by law to pay for each minute an employee is on site, including time 

spent answering Attestation health screenings, the system can round in increments of clock time, but 

there was previously not an option for rounded start time.  

What's been added: In the Pay Calc 2.0 rule, Round In/Out Time, a new section has been added in the 

Round Rules pop-up, Round By, which will round the actual punch time back or forward. Select an 

amount of time to round by, then choose if the system should round the time down (back) or up 

(forward).  

Example: The rule is configured for employees to have 5 minutes rounded down to answer 

an Attestation question before starting work, so if an employee punches in at 7:50 AM, they 

would get paid starting at 7:45 AM. The rounded time is reflected in the Calc From column in 

the timesheet. 

Pay Calc 2.0: Workday Breakdown Worked Incorrectly with Default CCs 
Previously, workday breakdowns did not process Time Off by time entry when employees had Default 

Cost Center in their Workday Breakdown profiles. 

What's been added: A new setting, Distribute Per Time Entry, has been added to the Distribute By 

Workday Breakdown rule. When this setting is enabled, each time entry will be processed to distribute 

Cost Centers according to the Workday Breakdown profile. 

Tip: When the rule is set up in conjunction with other rules that split time entries, the Use 

Calculated Time setting should be enabled. 

Points 

Points Accumulated for Dates when Employees were Terminated 
Previously, when an employee was terminated and re-hired, the dates that they were terminated and 

not active in the company were still accumulating points. 

What's been added: For TLM + Payroll and TLM + HR companies, a new checkbox setting has been 

added to the Points Profile, Do not calculate points for days which fall between terminated and 

rehired date. When this setting is enabled, termination dates will not be included in the point 

calculation.  
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Reports 

Added Page Level Buttons to All Punches Report  
From the All Punches report, users can now easily switch to other reports,  

• All Punches Summary 

• All Punches Details 

 via the following action buttons at the top of the page: 

• Detailed  

• Summary 

Added Page Level Buttons to Calculated Time Reports 
Under the following Calculated Time reports, 

• Time > Reports > Calculated Time > Detailed Calculated Time 

• Time > Reports > Calculated Time > Calculated Time Summary  

• Time > Reports > Calculated Time > Calculated Time Summary > Calculated Time by Work Day  

• Time > Reports > Calculated Time > Calculated Time Summary > Calculated Time by Week  

• Time > Reports > Calculated Time > Calculated Time Summary > Calculated Time by Calendar Day 

users can now easily switch to other reports,  

• Detailed Calculated Time (Counters) 

• Detailed Calculated Time (Counter Summary) 

• Detailed Calculated Time (Time Entries) 

 via the following action buttons at the top of the page: 

• View Counters 

• View Counter Summary 

• View Time Entries 

The View By toggle that was previously in the Current View drop-down in these reports is no longer 

available. 

All Cost Centers Report: Mass Edit & New Columns Added 
A Mass Edit button has been added to the All Cost Centers report, located under My Info > My Reports 

> System Reports > System Utilities > All Cost Centers. This option will allow you to enable/disable the 

Visible and Allow Time Allocation Towards settings within cost centers. This is useful for companies 

who no longer want time allocated against cost center or to even have it visible to users.  

Within the report, add the Checkbox: Select Row column. This will enable you to select one or more 

cost centers which will then activate the Mass Edit button. Upon selecting the button, a pop-up 

displaying the two settings will display. Checking the options makes them active. Unchecking them 

deactivates those settings.  
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To allow you to report and filter on each cost center level within the cost center full path, the following 

columns have been added to the report. When adding columns to the report, you will see 10 entries for 

each of the below. 

• Cost Center Name (1-10) 

• Cost Center Description (1-10) 

• Cost Center Abbreviation (1-10) 

• Cost Center External ID (1-10) 

• Cost Center Payroll Code (1-10) 

Display Comment Added by Employee on TSCR Report 
Previously, when comments were added by an employee in a timesheet change request, there was no 

option for the employee to view their comments after the change request was submitted.  

What's been added: A Request Comment column is now available to add to the Timesheet Change 

Requests report for employees (My Time > Timesheet > Change Requests). This will allow employees to 

view their comments that were entered in a submitted timesheet change request.  

Note Text Column in Attestation QA Report Updated 
Previously, the Note Text column in the Attestation Questions and Answers report included the 

employee's name and time stamp of the time entry, which is information that is already contained in the 

First Name, Last Name, and Completed On columns. 

What's changed: The Note Text column in this report will now only contain the Attestation prompt 

comment entered by the user. 

Time Off Roster Export Updated 
In the previous release, the cells in the Time Off Roster report displayed colors configured in the time 

off definitions. In this release, when you export the Time Off Roster report as a PDF, the export will 

display the report with these colors.  

Timesheet 

Important: The Classic Timesheet is being retired soon and will be replaced with the New 

Timesheet. Be sure to try out the New Timesheet Experience before the toggle button is 

removed during the next release cycle between June 14th and July 29th.  

The following is an example of the Time Entry tab on the New Timesheet for a Start/End (All Days) 

timesheet profile: 
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Adjusted Fields in Timesheet Columns on Editable Tabs 
Previously, when only a few columns were enabled on the new timesheet, some of the dynamic 

columns displayed excessively wide. 

What's changed: The widths of the column fields for editable tabs (Time Entry, Extra Pay, Extra Pay 

& Counter Adj, and Adjustments) will now be limited so that all columns will display in proportion to 

one another. 

 

These are look back rules that allow you to set up a Leave of Absence category or counter where it looks 

back up to one year and calculates what the average scheduled hours worked were.  

From the Divide the Total Hours Scheduled By drop-down, choose from the following options:  

Counters (if using the Counter version of the rule) 
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• The Number Of Calendar Days 

• The Number Of Contracted Days (the system will calculate how many days employees are 

contracted for, which will be used to calculate the average) 

• The Number Of Days Scheduled 

• The Number Of Weekdays (Mon-Fri) 

Indicate if your company is using Advanced Scheduler or not by enabling/disabling the Use Advanced 

Scheduler checkbox.  

The Look Back period can be defined by the number of days, weeks, etc.  

If you choose Multiplier, enter the time in the From / To fields (number of hours an employee works), 

and enter a number value in the Multiplier field, which is the number that is the employee's 

entitlement. You can also set up multiple tiers for increments of entitlement hours. The same logic is 

applied to Accrual Value, except that this uses values.  

If Use Advanced Scheduler is not enabled, you can filter out a Schedule Daily Rule and Day Type.  

You also have similar options to other entitlement rules, such choosing the Entitlement period and 

enabling Clear Previous Entitlement.  

If you are configuring the Entitlement Based On Averaged Worked Hours or Entitlement Based On 

Averaged Worked Hours (Counter) rules, the rules work the same way except that they calculate the 

average worked hours.  

Another difference is that If Any Time Entry Matches Filter is available for these two rules, which is a 

time entry filter that picks up specific time entries.  

If you are a Pay Calc 2.0 company and are using the Entitlement Based On Averaged Worked Hours 

(Counter) rule, you will have the option to use the Counter Eligibility Filter.  

Cost Center Lookup: Quick Search Option 
A Search tab in the timesheet Cost Center lookup is now available for mobile devices so that you can 

quickly search for cost centers by name. When you open the browse for cost centers option, the Search 

tab will display by default. 

Cost Center Manager Could Edit Time Entries After Timesheet Approved 
Previously, when a direct manager submitted the final approval of their employee's timesheet, cost 

center managers could still access the employee's timesheet and edit their time entries, despite the 

approved timesheet being read-only and ready for Pay Prep.  

What's been added: A new setting (disabled by default), Restrict Editing Time Entries On Approved 

Timesheets, has been added to the Managed Cost Centers widget. When this setting is enabled, cost 

center managers will be prevented from editing time entries from a timesheet that is in the Approved 

(Pay Prep Ready) status.  

Display Account EIN on Printed Timesheet 

Previously for multi-EIN companies, the default company EIN name displayed on the employee's printed 

timesheet regardless if they were in a different EIN.  
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Going forward, if a company is multi-EIN and Header is enabled in Print Settings, an employee’s account 

EIN will now display both in the header of the print preview and in the printed timesheet.  

Display Employee Default CC Next to Employee Name and Tooltip 
Users now have the option to see an employee's Cost Center name and full path next to their name on 

the timesheet. 

 

What's been added: In the Timesheet Profile, within the Extra Settings section, a new widget option has 

been added, Display Default Cost Center.  

 

When this option is checked, the following will display that you can enable: 

Display Full Path Tooltip: If this option is enabled, a tooltip icon will display next to the employee's 

name on the timesheet, and when you hover on the tooltip, the tooltip window will display the name of 

the Cost Center and the full path. 

Default Cost Center 1-9: You can enable up to 9 default cost centers, which will display in parenthesis 

next to the employee's name, with each separate Cost Center name separated by a comma. Only the 

Cost Center name will display, not the full path. 

Fixed Columns in Bulk Timesheet 
Previously, when scrolling horizontally in the Bulk timesheet, users lost visibility of data columns for the 

time entry, which made it difficult for users to enter time data accurately. 

What's changed: When users scroll horizontally on desktop, the left side of the timesheet that contains 

the following columns will now remain fixed: 

• Cost Center 

• Time Off 

• Duration Type 
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• Shift Premium 

• TE Extra Fields 

• Rate Tables 

Fixed Columns in Start/End Timesheet 
In the previous release, the Date and Action columns under the Time Entry tab were fixed at the left of 

the timesheet so that you can always see the data in these columns when you scroll. In addition, the 

Daily Totals were moved from above the days to below the days in order to improve the flow of time 

information. 

In this release, the Date and Action columns in all other tabs in the timesheet (Extra Pay, Extra Pay & 

Counter Adj, Calc Detail, Piecework and Adjustment) will also remain fixed at the left of the timesheet. 

In addition, the Daily Totals have been moved from above the days to below the days in these tabs.  

Link to Most Recent Timesheet that Falls Past Termination Date 
As previously available in the Classic Timesheet, in the New Timesheet, when attempting to access a 

terminated employee's Current Timesheet from their Employee Quick Links and the timesheet dates fall 

past the termination date, the system will now display a message with a hyperlink to the last accessible 

timesheet. 

New Adjustable Blank Column  
Previously, when only a few columns were enabled in the timesheet, one or two of the columns filled 

most of the timesheet space, which provided unnecessary blank space.  

What's changed: A blank column has been added on the right of the timesheet. It has unlimited 

extension, which gives you the flexibility to control the width space of the other columns through this 

blank column.  

Timesheet Mini Header 
In the event that the timesheet does not horizontally fit the screen, a mini-header will appear with all 

the action buttons, icons and secondary punch buttons. The punch buttons will display in the form of 

split buttons, as seen in the mobile device footer. 

Timesheet Print Option Includes Days with No Data  
For managers or employees printing timesheets, users now have the option to include all days of the 

period, even those without data (time entries or meta data). 

What's been added: The Timesheet Print Settings now contains a new setting, Include Days Without 

Entries, under Time Information.  

When this setting is enabled, the printed timesheet will include all days on the timesheet, including 

those without time entries or meta data. When this setting is disabled, the printed timesheet will only 

include days with data. 

Time Off  

NEW Updated Time Off Calendar by Month 

Important: The Monthly Time Off Calendar report will be enhanced with the new look and 
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feel during our next release cycle between June 14th to July 29th. 

 

WFR-188943: The Time Off Calendar by Month report (under Team > Time > Time Off > Reports > Time 

Off Calendar > Time Off Calendar by Month or My Reports > Time Reports > Time Off Calendar > Time 

Off Calendar by Month) has been updated to a new look.  

Note: The Time Off Calendar by Year and Time Off Calendar by Week reports will be 

updated to a new look and feel in a future release.  

This responsive monthly view of the Time Off Calendar report includes events and approved and 

pending approval time offs.  

 

The following is an example of the Time Off Calendar by Month report in a mobile device: 
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Time Off Calendar: Pop-Over/Pop-Up 
One of the new features of the updated Time Off Calendar by Month report is the ability to select the 

time off event on the calendar and a pop-over will display so that managers can see the details of the 

employee's time off. For multiple time offs, the date range will display in the pop-over, even though the 

events will display separately in the calendar.  

If there are multiple time off events in a calendar day, whichever time off you select in the day, that will 

display first in the pop-over with the other time off events below it. You have the option to expand and 

collapse the details in the pop-over.  

If there is a time off range, the range will display, as well as the total amount of time in the time off.  

 

Visual indicators for Dynamic Duration time offs will display in the event pop-over and calendar days. 

These icons show the time off duration. The duration icons will display for pending and approved time 

offs for single and multiple days.  
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Employee time offs will display in order of approved then pending. If all of the time offs cannot fit in the 

screen, a 1+ icon will display, which you can select, and A Time Off Information pop-up will display all of 

the time offs for that day. You can also select the date to access to the same pop-up. You can filter from 

the Filters window which types of time offs should display in this pop-up. 

Time Off Calendar: First Weekday 
Managers can change the first weekday in the Time Off Calendar by Month report. From the First 

Weekday filter, you can choose which day of the week the Time Off Calendar should start on. You can 

also save this as a saved view.  

Time Off Request Documents: Delete and Edit Icons 
If the Time Off Profile setting, Time Off Requires Attached Document is enabled, the delete and edit 

icons will not be available for consolidated and non-consolidated time offs in the Employee Documents 

report.  

Time Off Request: Timeline on Time Off Modify Pop-up 
If security permissions are enabled and if available in the Time Off Profile, the timeline that displays 

Restrictions and Schedules that is currently available in the Time Off Request pop-up, Time Off Request 

Calendar, My To-Dos, All Open report, and Pending Approval report, will now be available in the 

Modify Time Off pop-up. 

 

Time Off To Dos: Added Notes Pop-Up 

Previously, managers could not view comments in their My To Do Items while approving time offs.  
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What's been added: A Comment field with a notes icon has been added to My To Do Items for 

Approve/Reject Time Off Request so that managers can read the comment when reviewing their To Do 

Items. 

Time Off To Dos: Extra Approval Items Bypassed when Approving Time Offs 
Previously, when managers mass selected multiple time offs in their My To Do Items then selected 

Approve or Reject, the Unresolved Items pop-up was ignored, and managers could not choose to 

resolve the actions or skip.  

This has been fixed, and going forward, the mass/single time off approval functionality in My To Do 

Items will work as expected, including the Unresolved Items pop-up displaying for managers to take 

action.  

Workflows 

Added Approve Level 1 Override Selection to Recipient List 
Previously, the Approve/Reject step of the Timesheet Workflow did not contain the option To Be 

Completed By: Approve Level 1 Override group. 

What's changed: An Approve Level 1 Override option has been added to the list of available approvers 

in the To Be Completed By drop-down within the Approve/Reject step of the Timesheet Workflow. 

In addition, a new checkbox setting, Skip Override Managers, has been added to the Approve/Reject 

step to separate managers of specific approve levels and the ones with override permissions. This 

checkbox will appear when Approve Level X is selected in the To Be Completed By field, which when 

enabled, will limit To-Do Items being generated for managers without override permissions. 

Added Warning Message on Global Policies Tab  
A warning message, This company is not using workflow functionality made mandatory in R74. Please 

update Workflow Policy: (workflow type), has been added to the Global Polices tab if your company 

still uses non-workflow functionality. 

Attestation Workflow Notes Tag  
Previously, for employee who are required to submit a reason and/or note with their Attestation 

response, there weren't notes and reason code tags available in the Attestation Workflow Generate 

Notification step.  

What's been added: Two tags have been added to the Attestation Workflow Generate Notification 

step, Attestation_Note and Attestation_Reason_Code, which can be included in the notification email 

for the manager to review the employee's Attestation note and/or reason code. 

Display Comment from TSCR in Timesheet Notes 
When employees enter comments in a Timesheet Change Request, those comments will now display in 

the timesheet both in the time entry notes under the Notes column and in the All Timesheet Notes at 

the top of the timesheet.  

TSCR Approved Notification: Added Tag  
Previously, details of the approved change request were not included in the body of the approved 

notification.  
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What's changed: A tag will now be included by default in the Global Notification and Generate 

Notification step of the Timesheet Change Request workflow. The tag will display as a table containing 

information related to the old and new values related to the approved change request. 

Feature Retirements 
The following table describes functionality that has been retired or is planned to be retired.  

Product or 

Component 
Feature Menu Path 

User 

Experience 
Reason 

Planned 

Retirement 

Date 

TLM Classic 

Timesheet 

view 

N/A All All timesheet users 

will be switched to 

the New Timesheet 

view, and the Classic 

Timesheet view will 

no longer be 

available. 

Next release 

cycle: June 

14th to July 

29th. 

TLM Rules 

Analysis 

page 

Team >Time > Reports > 

Time Allocation > Rules 

Analysis  

and 

My Info > My Reports > 

Time Allocation > Rules 

Analysis 

All This page will no 

longer be supported. 

June 2021 

TLM TLM 

Classic 

Time Prep 

screen 

N/A All All TLM Time Prep 

users will be switched 

to the updated Time 

Prep screen, and the 

Classic screen will no 

longer be available. 

Next release 

cycle: June 

14th to July 

29th. 

TLM Classic 

Time Off 

Calendar 

by Month 

report 

N/A All The Classic Time Off 

Calendar by Month 

report will be 

updated to the new 

look and feel, and the 

Classic report will no 

longer be available. 

Next release 

cycle: June 

14th to July 

29th. 
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Payroll 

IMPORTANT! Quick Payroll Under Construction 
In the February 2021 release notes, we notified you that we are in the process of making some needed 

and required UI changes to Quick Payroll, and that the functionality would not be available when the 

April 2021 release was applied to your server. We mentioned that the unavailability probably would 

extend into future releases. As of this release (June 2021), the work is still continuing. When it is ready, 

we will notify you in the release notes. 

Base Compensation Maintenance Menu Path 
The menu path to access Base Compensation Change Reason Codes has been changed to Company 

Settings > Global Setup > Global List Definitions > Base Compensation Change Reason Codes . This 

change was made to allow Payroll-only companies to access and customize their Base Compensation 

Change Reason Codes. The Base Compensation required checkbox in the Account Policies widget of 

Company Setup will now be hyperlinked for both HR and Payroll only companies. The hyperlink will take 

you to the menu option mentioned above. 

Note: If a company containing both HR and Payroll sub-systems is copied and HR is then 

disabled in the copied company, the new menu option and hyperlink will be available in the 

copied company containing only the HR sub-system. 

 

COVID-19 Healthcare Credits 
Based on additional research, the COVID-19 Health Care credits will now only include ER contributions 

from deduction codes that have been identified as Eligible for Healthcare credits. Previously, the system 

included Employee Pre-Tax deductions (if selected on the deduction code), in addition to Employer 

Contributions. The CAA and ARPA User Guide will be updated to reflect the following: 

FFCRA Healthcare Credits: These are credits in addition to the FFCRA wages. The system calculates the 

credit by taking the percentage of healthcare credit that is associated with the FFCRA wages, like this: 

(FFCRA wages/Total Wages)*( ER cost of post-tax health insurance) 

CARES Healthcare Credits: CARES Healthcare Credits are included in the maximum retention credit. The 

system calculates the credit by taking the percentage of healthcare credit that is associated with the 

Retention wages, like this: 

(Retention Wages – any FFCRA wages)/(Total wages)*(( ER cost of post-tax health insurance)*70%) 

 

Updates to W4 Forms 
The following W-4 forms have been updated as follows. 

• Oklahoma: Current version. 
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• Idaho: Current version. The middle initial of employee now populates form. Line 2 of the non-

resident alien section now uses $12,550 for the calculation instead of using $12,400 (Line 1 x 

$12,550). 

• Form 2020 W4 field in W4s: Changed the field label to Form W4 2020 and later. 

• W4 field defaults and order: To improve the experience for users filling out W4 fields, several 

fields now default to the correct values and appear in the same order as they appear on the final 

W4 form. 
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Scheduler 

Hot Features in this Release 

Reports 

Scheduler Reports Auto Filter 
Previously, for any of the Scheduler reports, managers could see all scheduled cost centers listed in 

reports despite not being able to edit or view any schedules that they did not manage.  

What's changed: The system will now filter out any scheduled cost centers that a manager does not 

have manage permissions assigned so that managers will only be able to see their managed scheduled 

cost centers from any of the Scheduler reports.  

Scheduling Engine 

Added Seniority and Skill Level as Criteria when Auto Assigning Shifts 
Previously, employee seniority date and skill level had no effect on the scheduling engine criteria for 

auto assignment. 

What's changed: An employee's Seniority date in the Dates widget of the Employee Profile will now be 

considered by the scheduling engine for shift auto assignment, provided that there are no constraint or 

availability violations. In addition, Skill Level in the Skills widget of the Employee Profile will also be 

considered by the scheduling engine.  

As of this release, the seniority date takes precedence over skill level.  

Example: If employee A and employee B qualify for the same shift but employee A has an 

older seniority date, the scheduling engine will assign the shift to employee A. If employee C 

has a lower skill level than employee D, but employee C has an older seniority date, 

employee C will be assigned the shift. If employee E has a higher skill level than employee F 

and seniority dates are not chosen for both employees, employee E will be assigned the shift.  

 

Basic Scheduling  

Notifications were Not Generated via List Schedule Entries Report 
Previously for TLM and TLM + Scheduler companies, when users selected the Generate Notifications 

button from the List Schedule Entries report (Team > Schedule > Team Schedule View > List Schedule 

Entries), the system confirmed through a message that the notifications were generated, but the 

notifications were not actually processed for the selected employees.  

Going forward, the system will generate notifications from the List Schedule Entries report when 

Generate Notifications is selected, as expected.  

Updated TLM Basic Scheduling Manage Shift Window 
As previously available in Classic, the Manage Shift window in any of the TLM Basic Scheduler screens 

will now display Time Off underneath Availability/Preferences. The Time Off name will display (unless it 

is private) next to the time off hours if it is configured in Time Off Settings.  
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Schedule Fairness 

Allow Schedule Fairness Approval for Expired Shift Dates 
Previously, Schedule Fairness did not trigger when changes were applied to a shift with an expired date 

(a shift in the past). 

What's changed: Schedule Fairness rules will now trigger for changes made to the previous day's shift 

and automatically update schedule and extra pay for the employee. 

Schedule Template 

Schedule Template Start Date Matches Schedule Settings Cycle Date 
The Schedule Template start date will now match the Schedule Settings Cycle Start Date so that 

managers can easily control the dates to match Schedule Template import file dates. 

Feature Retirements 
The following table describes functionality that is planned to be retired.  

Planned Retirements 

 

Feature Menu Path User Experience Reason 

Planned 

Retirement 

Date 

Schedule 

Table 

View 

and  

Schedule 

Overview 

By Date 

Range 

Team > 

Schedule > 

Schedules 

  

Team > 

Schedule > 

Schedule 

Overview 

You will not be able to input 

shift times only for schedules, 

as well as copy and paste 

existing schedule time ranges 

from employee to employee. 

In addition, the PDF Print 

option will not be available. 

  

You will not be able to bring 

multiple schedules into one 

view. 

This view is not user-friendly. 

From any of the views, Print 

Preview will still be available, 

which includes the same 

information for printing with 

additional options as to which 

shifts should be included in the 

printout. 

  

This view is not user-friendly. 

You will still be able to bring in 

multiple schedules via the 

Summary By Employee report, 

but not in a schedule-like view. 

Next release 

cycle: June 

14th to July 

29th. 
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General 

Employee Profile: Single/Multi View Toggle 
A Single-Column View toggle has been added inside employee profiles. Switching the toggle on will re-

order the widgets in a single column. Switching it off will return the page to a Multi-Column view. This 

will not affect the Jump To panel on the left.  

Adjust Size Capability in Employee Profile 
Employee Profile users can now change the default width and/or height of their widgets in the Multi-

Column view, allowing them to see what is most important to them. An icon has been added to the top 

right of all widgets where user can select the Adjust Size option, allowing them to increase/decrease the 

width and height of widget.  

The Tile Width option is read-only when the one column view breakpoint is used for the Multi-Column 

layout. The available width adjustments are as follows: 

• In a 1 column layout of the Multi-Column view, a widget can only have 100% width. 

• In a 2 column layout, the widget can have 50% and 100% width. 

• In a 3 column layout, the widget can have 33.33%, 66.66% and 100% width. 

If a user increases/decreases the height of a widget, the change is also applied to the same widgets in 

that row. If a user increases the width of widget to be full width, the widgets previously on the same row 

drop to the next row. 

The changes made are applied to the Employee Profile, My Profile, and Applicant Profile.  

Dashboards 

Dashboard Improvements 

Within the Dashboard Layout Configuration page, spacing in the grid has been improved to reduce white 

spaces. 

Admins adding custom tabs and then selecting Apply will add the tab(s) to the layout. Selecting Save on 

the configuration page will push the custom tabs to the Dashboard Tab Library. Using the Apply option 

will not push the tabs to the library. This only affects Admins. It does not affect users who are allowed to 

edit their own dashboards. 

Admins using the Reset Changes button in the Dashboard Layout Configuration page will now receive a 

confirmation message stating, "Are you sure you want to reset your layout to its last saved state?"  

Admins working in the Dashboard Layout Configuration page will now have options available at the top 

of every section. This minimizes the number of clicks by having to access the options through the 

ellipses menu. The following will be available: 

• List View (middle section only)- Widgets/tiles occupy their own row and span the entire width of 

the section. 

• Matrix Review (middle section only)- Widgets/tiles are displayed with their last set positioning and 

size. 

• Re-Arrange Tiles- Exposes the rearrange panel for changing the order of widgets/tiles. 
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• Remove Section- Clears all widgets/tiles from the section and returns it to a blank state. 

• +Add - Provides access for adding widgets, report/chart tiles, and content widgets. 

Within the Dashboard Tab Library report page, new audit type columns have been added to view who 

and when actions were performed. The columns added are: 

• Created By - Provides the full name of the user who created a tab. 

• Modified By- Provides the full name of the user who last modified a tab. 

• Last Modified- The date and time when a tab was last modified. 

In the Dashboard Layout Profiles report page, a new icon/column is available to View Accounts 

Associated w/Profile. When selected, a report page displays showing all accounts with that profile. 

From that page you can access employee profiles and quick links. 

• Created By (User First and Last Name) 

• Modified By (User First and Last Name) 

• Last Modified (mm/dd/yyyy, data format depends on locale) 

In the Dashboard Tab Library, when creating a new tab, the option to Assign is available. This allows you 

to add the new tab to multiple profiles at the same time. The option will not be available for HR 

functionality of Onboarding, Pre-Boarding, or First Day Package). 

For Content Widgets created in transparent view, the ellipsis menu containing Adjust Size, Move To, 

and Remove options will be available when the page is put into Edit Mode.  

Users are now able to see Open Links from the Dashboard Tiles titles in a new tab using right click. 

When a user right-clicks on any Dashboard Tile with a link in the title and chooses Open Link in New 

Tab, the respective link opens in a new tab. 

 The word "Schedules" has been changed to Layouts in the following places: 

• The Layouts section on the Edit Dashboard Layout Profile page. 

• The Profiles lookup on the Dashboard Tab Library report. 

• The Profiles lookup on the Edit Tab page. 

The Description of Layouts appears in the Assign to Profiles lookup. 

Dashboard Layout Profiles 

Type Column Removed from Dashboard Layout Profile Report 

The Type column is no longer included in the Dashboard Layout Profile Report (Company Settings > 

Profiles/Policies > Dashboard Layout > Dashboard Layout Profiles) with the introduction of the 

Dashboard Tab Library. Type information has also been removed from the Edit Dashboard Layout Profile 

page. 

Remove Reset Option for Schedules of Dashboard Layout Profile 

Users with View and Edit permissions to the Dashboard Layout Profile report can now Reset Changes 

from the Dashboard Layout Configuration page (Company Settings > Profiles/Policies > Dashboard 

Layout > Dashboard Layout Profiles, Edit from the Layouts (Schedules) for the appropriate profile). The 



 

52 

Reset option has been removed from the Layouts (Schedules) report on the Edit Dashboard Layout 

page. 

Edit Tab from the Dashboard Layout Configuration Page 
Users can edit a tab via the Dashboard Layout Configuration page (Company Settings > Profiles/Policies 

> Dashboard Layout > Dashboard Layout Profiles, then click View/Edit for a layout (schedule)) so that all 

changes are saved to the Dashboard Tab Library. When the Dashboard Layout Configuration with tabs is 

presented on the page, an informational message displays at the top of every tab layout.  

"{Tab Name} is shared with # dashboard layout profile(s)." 

The informational message contains the number of profiles the tab is assigned to. 

By clicking the link in the message, the Profiles pop-up is opened. Upon clicking Save, a confirmation 

pop-up shows on the page explaining that the changes will be applied to the Dashboard Tab Library 

pages. By clicking Save, all changes on tabs are saved both in the profile and in the library.  

Updates on the Edit Dashboard Layout Profile Page 
Users with View/Edit permissions to Dashboard Layout Profiles now see a better structure of the Edit 

Dashboard Layout Profile page, making it more convenient to work on.  

• The "Schedules" section is now located under the Name and Description section, and has been 

renamed Layouts. 

• The columns in the Layouts section have been rearranged in the following way: 

• Edit 

• Delete 

• Effective From (date field) 

• Effective To (date field) 

• User Can Modify (checkbox) 

• Description (input field, 255 characters limit) 

• Tooltips have been added to the Show Company Hub and Show Custom Dashboards options in 

Dashboards Visibility. 
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Publish Changes from the Dashboard Layout Configuration Page 
Admins can now push changes to employees from the Dashboard Layout Configuration page (Company 

Settings > Profiles/Policies > Dashboard Layout > Dashboard Layout Profiles, then click View/Edit for the 

appropriate Layout (Schedule) so they can view relevant information on their Dashboard. A new option, 

Publish Changes, is available at the top right side of the page.  

Save must be selected to enable the Publish Changes option. When an admin clicks Publish Changes, 

the system shows a confirmation dialogue where the user can choose OK to continue or Cancel to close 

the pop-up. The verbiage reads: 

Publish Changes? 

You are about to publish changes for the layout associated with accounts assigned to {DLP name}. Do 

you want to continue? 

The changes are then published to the employees the profile is assigned to.  

If one or more Company Hub tabs are blank, the system disables the Publish Changes button and shows 

the following inline warning message: 

One or more of your Company Hub tabs are completely blank: Name of company hub tab #1, Name of 

company hub tab #2, etc. Publish is disabled until the tab(s) contain(s) at least one widget and/or 

content widget. 

Important: The system does not show the Publish Changes button for Layouts with past and 

future Effective Dates. 

Creating Other Layouts in Dashboard Layout Profile 

Second and subsequent Dashboard Layouts reuse all tabs that exist in the first Layout (Schedule) so the 
Dashboard Tab Library does not contain duplicates. When the Company Hub and Dashboard Tab Library 
are enabled for a company, users with View, Edit and Add permissions for the Dashboard Layout Profile 
item in their security profile can navigate to an existing or create a new Dashboard Layout Profile. 
Within the profile, users can click on an existing Layout (Schedule) or add a Layout (Schedule) using the 
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+Add option. When a user creates the next Layout (Schedule), the system reuses all tabs that were 
created for the last created Layout (Schedule) in this profile. 

Dashboard – Widgets 

New Widget Notification for the Checklist Widget 
For consistency with the release of other new Dashboard widgets, a pop-up notification has been 

created to announce the addition of the Checklist widget. This new widget pop-up notification displays 

to users with a Dashboard Profile assigned, and only displays once. Users can add the Checklist widget to 

their Dashboard directly from the pop-up, and can specify the Dashboard to which the widget should be 

added.  

Managing Client Content Widgets 

Content Widgets – Paste in Text Editor 
Admin Content Managers can now paste formatted text into the Text Editor. When the User 

clicks/presses the Paste button or right-clicks in the Content area, then selects the Paste option or 

simply uses the Ctrl + V action via the keyboard, the copied text from a Word Document is pasted with 

formatting. 

When the Paste as a text button is active, or the user right-clicks in the Content area and selects the 

Paste as a plain text option, then the copied text from a Word Document is pasted as plain text without 

formatting. 

Most formatting items such as bold, italic, underline, table, headings, symbols, etc. are supported except 

for the following items: 

• Indented text 

• Double spacing 

• Shapes, Smart Text, Clipart, images, charts, Word Art 

Note: The Paste as a plain text option is not supported by IE and Mozilla browsers. Also, 

currently the Paste button is not supported by browsers other than IE (for example, Chrome, 

Mozilla, Opera and etc.). A warning message displays reading: Whoops! Your browser doesn't 

support Paste action in the Text Editor. Please use the Ctrl + V (MacOS: Cmd+V) keyboard 

shortcut instead. 

Content Widgets - Auto-Size Checkbox Enhancements 
Admin Content managers can now view mask lines in the Text Editor component for inserted tables. 

Within the Create/Edit Content Widget pop-up (Company Settings > Profiles/Policies > Dashboard 

Layout Profiles > Content Widget Library > Create new Content Widget or Edit an existing one), the 

following updates have been made:  

The Auto-size height checkbox option has been moved to the top, between the Content section and the 

Text Editor. 

The Auto-size height checkbox option is renamed to Auto-size height (applies to full width widget 

inside each section). 
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When the Add / Edit Image pop-up is opened, users can see updated labels in Image Size, such as: 

• Fit is updated to Fit (100%) 

• Small is updated to Small (25%) 

• Medium is updated to Medium (50%) 

• Large is updated to Large (75%) 

Content Widget - Rich Text Editor Updates 
Content managers with access to the Text Editor can now see the TinyMCE licensing in the bottom right-

hand corner of the Text Editor. When the Text Editor is open, a POWERED BY TINY link displays that 

directs users to the tiny.cloud website.  

 

Content Widget - Rich Text Editor: Linking Video Files 
Admin Content Managers can now see an inline information message in case a linked video/video file is 

not supported. Users able to access the Text Editor can open the Insert/Edit media pop-up to view an 

informational message that reads: Not all sourced video URLs are currently supported, you can only 

insert links to videos hosted via YouTube, Vimeo, and Dailymotion. 

When a URL is not inserted or videos other than those hosted by YouTube, Vimeo, and Dailymotion are 

inserted, the Save button is disabled. 

Dashboard Tab Library 

Dashboard Tab Library Report 
A new Dashboard Tab Library report is now available under Company Settings > Profiles/Policies > 

Dashboard Layout > Dashboard Tab Library. Users can see a list of existing Dashboard tabs so they can 

manage them in one place. The Dashboard Tab Library report includes columns such as: 

• Checkbox 

• View/Edit 

• Delete 

• Clone 

• Name 

• Description 

• Type (Custom Tab or Company Hub Tab) 
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• View Profiles Associated With 

• Created 

All tabs that are created in the Layouts (Schedules) of Dashboard Layout Profiles are included in this 

report. 

Custom Tab Added to Dashboard Tab Library 
Users can now create new Custom tabs in the tabs library so they can assign it to several Dashboard 

Layout Profiles. Users with View, Edit, and Add permissions to the Dashboard Layout Profile report can 

select the Add New option on the Dashboard Tab Library report to add a new tab. 

Users must choose the appropriate Tab Type, such as Custom Tab. A question mark (disabled when the 

Tab Type field is empty) next to the drop-down offers additional information about the selected type. 

 

Users should input a Name and Description for the new tab. Once complete, the Dashboard Tab page 

appears upon clicking Continue. Users can then configure the tab by adding reports, charts, widgets, etc. 

Users are also presented with the options to Save and Reset Changes. 

Company Hub Tab Added to the Dashboard Tab Library 
Users with View, Edit and Add permissions to the Dashboard Layout Profile report can create new 

Company Hub tabs in the Dashboard Tab Library so they can assign it to several Dashboard Layout 

Profiles. 

 

Under Company Settings > Profiles/Policies > Dashboard Layout > Dashboard Tab Library (or by clicking 

View Dashboard Tab Library in the Dashboard Layout Profiles report), users can click the Add New 
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option and then select Company Hub Tab in the Tab Type drop-down. Users must enter a Name for the 

new tab, and they can also enter a description. Clicking Continue takes users to the Dashboard Tab page 

where they can configure the new tab by adding available widgets. Users are also presented with the 

options to Save and Reset Changes. 

A grid displays allowing users to add sections and items on the Dashboard Layout. When Save is 

selected, the new tab appears in the Dashboard Tab Library. 

Add Tab from Dashboard Tab Library in Dashboard Layout Profile 

Users with View and Edit permissions to the Dashboard Layout Profile report can add a tab from the 

Dashboard Tab Library to the Layout (Schedule) of a Dashboard Layout Profile so they can chose from 

existing tabs. The Gear icon is available in the header of a Dashboard (Company Settings > 

Profiles/Policies > Dashboard Layout > Dashboard Layout Profiles, Edit for the appropriate Layout 

(Schedule)) to Edit Tabs. 

 

 

When the Edit Dashboard Tab pop-up is presented on the page after clicking Edit Tabs from the Gear 

icon, an Add From Library button displays and is available on both Company Hub Tabs and Custom Tabs. 

By clicking the Add From Library option, a report-based lookup entitled Add From Dashboard Tab 

Library opens with options pulled from the Dashboard Tab Library report ( Company Settings > 

Profiles/Policies > Dashboard Layout > Dashboard Tab Library). 
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This lookup is filtered depending on which tab of the pop-up it has been opened from, Custom Tabs or 

Company Hub Tabs. After clicking Apply in the lookup, the user is returned to the Edit Tabs pop-up. By 

clicking Save in the Edit Dashboard Tab pop-up, the selected tab(s) appear on the Dashboard. 

Users cannot rename added tabs. If a user deletes tabs in the Edit Tabs pop-up, they are only removed 

from the Dashboard Layout Profile, not from the Dashboard Tab Library. 

Existing Tabs Migrated to Dashboard Tab Library 
Users with View and Edit permissions to the Dashboard Layout Profile report can now see previously 

created tabs in the Layouts (Schedules) of Dashboard Layout Profiles so they can Edit them and assign 

them to other profiles. All existing tabs from the Dashboard Layout Profiles have been migrated to the 

Dashboard Tab Library (Company Settings > Profiles/Policies > Dashboard Layout > Dashboard Tab 

Library). 

View Dashboard Tab Library from Dashboard Layout Profiles Report 
Users can view the Dashboard Tab Library from the Dashboard Layout Profiles report (Company Settings 

> Profiles/Policies > Dashboard Layout > Dashboard Layout Profiles) so that I can see the list of existing 

tabs. By clicking the View Dashboard Tab Library option, users are redirected to the Dashboard Tab 

Library report. Users can also choose View Content Widget Library to go to the Content Widget Library. 

 

View/Edit Dashboard Tab from Dashboard Tab Library 
Users with View and Edit permissions to the Dashboard Layout Profile report can view and edit 

Dashboard tabs in the Dashboard Tab Library report (Company Settings > Profiles/Policies > Dashboard 

Layout > Dashboard Tab Library or click the View Dashboard Tab Library in the Dashboard Layout 

Profiles report) so they can assign it to several Dashboard Layout Profiles. 

Once the user clicks View/Edit Tab for an existing tab, the Dashboard Tab page appears where the user 

can re-configure the tab when the Edit Mode is enabled. By clicking Save, all changes are applied to the 

associated Dashboard Layout Profiles automatically. 

Edit Tab Name and Description 
Users with View and Edit permissions to the Dashboard Layout Profile report can now rename tabs so 

they can assign a more informative name to it. Users can click Add New Custom Tab or Add New 

Company Hub Tab, or users can also click View/Edit Tab for an existing tab under Company Settings > 

Profiles/Policies > Dashboard Layout > Dashboard Tab Library. 

A Tab Settings: {Tab Name} option appears next to the Tab Type at the top of the page. By clicking the 

{Tab Name} link, a pop-up with the following fields appears: 

Name: This is a text field with information added while creating a tab. It is a required field with a 

maximum of 80 characters. 
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Description: This is a text field with information added while creating a tab. It is an optional field that 

can be left blank with a 255 character limit. 

By clicking Save in the pop-up, the new name will appear in the Dashboard header. By clicking Save at 

the top of the page, the updated information will appear in the related columns of the Dashboard Tab 

Library report. 

 

 

 

Delete Dashboard Tab from Tab Library 
Users can now delete Dashboard tabs so that only relevant tabs are presented in the Dashboard Tab 

Library report ( Company Settings > Profiles/Policies > Dashboard Layout > Dashboard Tab Library). A 

Delete column has been added to the report, and by clicking delete, users can confirm the deletion by 

selecting Delete in the pop-up. By clicking Delete in the pop-up, a success message that reads 'Tab 

Name' was successfully deleted appears on the page and the selected tab is removed from the report. 

User cannot delete any tabs assigned to profiles, so the Delete icon is absent in the appropriate row. 

Clone Dashboard Tab in Tab Library 
Users can now Clone an existing tab in the Dashboard Tab Library so they can modify its initial state 

without affecting the original tab. Users can choose the Clone Tab option on the Dashboard Tab Library 

report (Company Settings > Profiles/Policies > Dashboard Layout > Dashboard Tab Library) to clone an 

existing tab.  

 

Upon clicking Clone Tab, a confirmation message appears where users can confirm they want to clone 

the tab by selecting Clone.  

 



 

60 

When the user clicks Clone in the pop-up, the selected tab is cloned with the name Copy of {tab title}. 

Subsequent copies of the same tab are to contain indexation (for example, Copy of {tab title}(1), Copy of 

{tab title}(2), etc.), and copied tabs are placed in alphabetical order in the report.  

After confirming, a success inline message appears; {Tab Title} was successfully cloned. 

Publish Changes Option for Individual Tab 
Users can Publish Changes made to individual tabs for end users so the rest of the tabs are not affected. 

When a user navigates to the Edit Tab page in the Dashboard Tab Library, a Publish Changes button 

displays as a page level action and becomes available after a tab is created. The Publish Changes button 

becomes available only after clicking the Save button at the top of the page. 

By clicking the Publish Changes button, all changes made on the tab are applied to end users who have 

the tab assigned to the active Layout (Schedule) in their Dashboard Layout Profile. The Publish Changes 

button becomes disabled if a tab is not assigned to any profile, and the following inline info message 

displays: Publish is disabled, tab must be assigned to at least one Dashboard Layout Profile. 

When a Company Hub tab is blank, the system disables the Publish Changes button and shows the 

following warning message: Company Hub tab is completely blank . Publish is disabled until the tab 

contains at least one widget and/or content widget. 

If the tab already exists, the content of the tab is reset/overwritten. If a user has deleted a tab and an 

Admin publishes it, the tab re-appears on the user's Dashboard with the latest data.  

After clicking Publish Changes and OK to continue, a success message displays: Dashboard layout(s) 

associated with [Name of tab] successfully received published changes. The names of the associated 

Dashboard Layouts are shown on the subsequent lines of the message.  

Mass Assign Dashboard Tabs 

Users with View/Edit permissions to Dashboard Layout Profiles can now Mass Assign Dashboard tabs to 

Dashboard Layout Profiles using the Assign To Profiles option (Company Settings > Profiles/Policies 

> Dashboard Layout > Dashboard Tab Library) so they can show one tab in multiple profiles 

simultaneously.  

Employee Profile 

Default View of Multi-Column View 
Where users have not made any modifications to their Multi-Column view (i.e. expanded collapsed 

widgets or panels), the default views have been updated as follows:  

The default view of the Multi-Column profile has been changed (applies to the Employee Profile, My 

Profile and Applicant Profile) so that now: 

• The Jump To panel is collapsed. 

• The Profiles panel (if configured) is collapsed. 

• All widgets are opened. 

The default view of the Single Column layout has been changed (applies to the Employee Profile, My 

Profile and Applicant Profile) so that now: 

• The Jump To links are open. 
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• The Widgets are open. 

• The Profile panel (if configured) is closed. 

Once a user makes any configuration changes to their profile by opening or collapsing panels or widgets, 

that configuration is retained and the default view is no longer applied. 

Employee Profile Adjust Size: Save User Configuration 
Users can now configure their Employee Profile view with a mix of half and full width widgets and utilize 

that same view when returning to their profile. The Adjust Size configuration a user has made applies 

only to the Multi-Column view of the Employee Profile, and it is saved across sessions.  

This applies to the Employee Profile, My Profile and Applicant Profile, however all views are considered 

different configurations. For example, if you configure the Personal Info widget to be full width in the 

Employee Profile, that does not mean the widget is also full width in My Profile. 

General 

Allow Multiple Alternate Managers 
Previously, managers could delegate to only one manager at a time. 

What's Changed: Under Settings > Global Setup > Groups > Manager Group Access, a manager now has 

the ability to assign up to five alternate managers who will have the same permissions as the original 

manager. They will also receive the same To-Do items. 

 

 

By clicking the Assign To Profiles button, the Assign To Profiles lookup is opened. After choosing the 

appropriate profiles and clicking Assign, the selected tabs are assigned to the selected Layouts 

(Schedules) and a success message (Dashboard Tabs were assigned successfully) appears on the page. 
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